Photoshop hiç kuşkusuz her türden kullanıcının göz bebeği bir program. Bu program ile hazırlanmış püfler, efektler ve işinize yarayacak adım adım uygulamaları bir araya getirdik.

1-AUTO AYARLARININ ÖZELLEŞTİRİLMESİ
Photoshop içerisinde Curve, Levels tablolarının auto değerlerini, siyah ve beyaz renk piksellerini kendi default değerlerinde ayarlıyor. Photoshop 6’da Curves ya da Levels tablosunu açın; “alt” tuşuna bastığınızda Auto butonu Options butonuna dönüşecektir. Alt tuşu basılı durumda iken Options butonuna tıkladığınızda açılan pencereden değerleri değiştirebilirsiniz. Photoshop 7’de durum daha kolay. Curves, Levels tablosunda Options butonu doğrudan karşımıza çıkıyor. Özellikle PS7 içerisinde Shadow, Midtones, Highlights seçeneklerine özel renkler girebilir, farklı efektler elde edebilirsiniz.

2-OPACITY DEĞERLERİNİ KLAVYEDEN DEĞİŞTİRME
Toolbox araçlarından brush, stamp (boyama ve rötuş) araçlarından herhangi biri seçili durumdayken klavyeden girilen nümerik değerler, bu araçların opacity değerlerini değiştirir. Seçim araçları, crop, move seçiliyken girilen nümerik değerler, bulunduğunuz layer’ın opacity değerini değiştirecektir. Opacity değerlerine klavyeden 48, 62 gibi küsuratlı değerler girebilirsiniz.

3-COLOR RANGE
Color Range renge duyarlı bir seçim aracıdır. Color Range penceresinde yer alan damlalık araçlarının yardımıyla belirlenen renkler pencere kapatıldığında bir seçim alanına dönüşür. İşlevli ve yoğun kullanılan bir Photoshop aracıdır. Color Range penceresinde yer alan Selection ve Image seçenekleri, seçim çalışmanızın açık olan belgenin ön izlemesi ile birlikte çalışmanıza olanak sağlar. Pencerede yer alan Seçim değerlerinizi kaydederek başka bir çalışmanızda tekrar kullanabilirsiniz. Select açılan menüsünden renge duyarlı seçim çalışması yapabilirsiniz. Belirli bir renk hakimiyetinin olduğu belgelerde kullanılabilir. Color Range’in en önemli araçları damlalıklar. Select menüsünün seçeneğini ‘Sampled Colors’ yapın, en altta bulunan ‘Selection Preview’ bölümünde de Grayscale seçeneğini aktif yapın. Üç damlalıktan ‘+’ simgeli olanı seçin ve örnek resimdeki Zebra’nın siyah kuşaklarının açık, orta ve koyu bölümlerine tek tek tıklayın. Her tıklayışınızda Zebra’nın kuşaklarındaki belirginliği görebilirsiniz. Seçim için renk ekleme ve çıkarma işlemi için iki ayrı damlalığı kullanmanın yanında birinci damlalığa tıklayıp istediğiniz renk tonunu seçtikten sonra seçime yeni noktalar dahil etmek için shift tuşunu kullanabilirsiniz. Alt tuşuna basarak da seçimden nokta çıkarabilirsiniz.

4-REPLACE COLOR
Kullanımı kolay bir renk işleme aracı. Örnek çalışmada Photoshop’un kendi örnek dosyalarından bir tanesini açarak, damlalık aracına tıkladım. Çalışma belgesi üzerine giderek shift tuşu yardımıyla kumların açık, orta, koyu bölümlerine tek tek bastım. Transform bölümünde bulunan Hue Saturation sürgüleriyle renk değişimi aldıktan sonra çalışma belgesi üzerinde değişimi izledim. Değişimin sağlıklı olmadığı bölgelerde yine damlalıkla, shift tuşuyla tıklayarak onları maske içerisine dahil ettim.

5-CMYK RENK MODUNDA RGB FİLTRELERİ
Photoshop filtrelerinin çoğu RGB renk modunda çalışır. CMYK renk modunda iken ister kanallara tek tek, ister Quick Mask ile RGB filtrelerini CMYK modda kullanabilirsiniz. Yeni bir Alpha kanalı oluşturun ve Filter menüsüne göz atın, hemen hemen tüm filtrelerin aktif olduğunu göreceksiniz.

6-FADE
Photoshop tüm alternatif araçlarıyla bize neredeyse sınırsız bir güç veriyor. Kullanılan tüm araçların farklı tarzlarda yorumlanmasıyla kolayca hoş sonuçlar elde edilebiliyor. Fade özelliği de bunlardan biri. Çalışma belgesine herhangi bir filtre uyguladığınızda, Edit menüsü altında aktif hale gelen Fade’e tıklayın. Açılan pencereden, son uyguladığınız filtrenin Opacity değerini, bununla beraber etkili olmasını istediğiniz Layer Mode’larından birini seçebilirsiniz.

7-AÇISI BOZUK BELGELERİ DÜZELTME
Servis bürodan gelen taramalar, çoğunlukla açısı bozuk görsellerdir. Bu durumda kullanılan iki açı düzeltme yöntemi var. Biri; çoğunlukla kullanılan Crop, diğeri de Rotate Canvas. Açısı bozuk olan belgenin açısını düzeltmek için Toolbox’tan cetvele (Measure) tıklayın ve belgenin sol alt köşesinden sağ alt köşesine bir doğru çizin. Info araç penceresinde bu değer gözükecektir. Ardından Rota’te Canvas’tan Arbitrary komutunu verin; açılan pencerede düzeltilmesi gereken açı değeri yazıyor olacaktır.

8-CROP ve TRIM
Çalışma sırasında belgenizi kadrajlar ve kullanmayı düşünmediğiniz alanları atarsınız. Crop, bu noktada en çok tercih edilen araçtır, fakat özellikle feather ile yumuşatılmış piksellerin crop yapılmasında istenmeyen sonuçlarla karşılaşabiliyoruz. Hassas crop’lamalarda (özellikle layer’lı bir çalışmada) Trim saydam alan içerisinde piksellerin dayandığı alanın dışında kalan bölümü atarak crop yapar. En küçük piksel değerini algılayarak hareket eden Trim, bu noktada oldukça sağlıklı sonuçlar veriyor.

9-PHOTOSHOP AÇILIŞ PÜFLERİ
Programların duyarlı oldukları tuş kombinasyonları vardır. Photoshop’un da buna benzer bir özelliği söz konusu. Klavyeden Alt ve Command tuşlarına birlikte basın; bırakmadan Photoshop’u açın; açılıştan kısa bir süre sonra size Plug-in klasörünü soracaktır. Buradan devre dışı bırakabilir yada başka bir klasörü tanımlayabilirsiniz. Bu aşamadan sonra tuşlardan elinizi kaldırın ve tekrar Alt ve Command tuşlarına basın; kısa bir süre sonra da Scratch Disks ayarlarını gösteren bir pencere açılacaktır. Bu HD’nizde yer kalmadığı durumlarda başka bir HD’yi tanımlamanıza yarar.

10-LAYER’DA OPACITY ve FILL
Photoshop 7 ile birlikte arayüzde değişimler söz konusu. Bunlardan bir tanesi Layer araç paletinde bulunan Opacity ve Fill araçları. Bunların arasındaki farkı bir örnek üzerinde işleyelim.
Bir yazıya, fotoğrafa Layer Style’ları kullanarak efekt uyguladığımızı düşünelim. Fill değeri Layer Style uygulanmış yazıyı ya da fotoğrafın yoğunluk değerini (opacity) değiştirir. Bu esnada Style değerlerinde hiçbir değişiklik olmaz. Opacity sürgüsünde yapılan değişiklik hem Layer Style hem de Style uygulanmış layer’ın yoğunluğunu (opacity) etkiler.

11-LAYER GRUPLAMA
Photoshop içerisinde iki layer’ı birbirinin içine gömmek, geçişler yapmak için küçük bir püf noktamız var. Yapacağımız işlemin aynısını klavyeden Alt tuşuna basılı tutarak, mouse ile iki layer’ın tam ortasındaki çizgiye geldiğinizde, mouse’un kursörü değişir, bu noktaya tıkladığınızda layer’lar gruplanmış olur. Bu çalışmayı menüden yapmak için ise, örnek resimde olduğu gibi bir hazırlık yapalım. Üst layer’ı altında bulunan yazı içerisine gömmek için ilk olarak yazının bulunduğu layer ile üst layer’ı link ile bağlıyoruz. Klavyeden Command+G tuş kombinasyonunu uygulayın. Yandaki resimde görmüş olduğunuz gibi üst layer alt layer’daki yazının içine girdi.
Bu yöntemin link kullanılmadan yapılabilmesi için örnek resimde Layer 1’e tıklayarak yazının ya da içine gömülecek layer’ın da altında olmasına dikkat ederek yine aynı komutu verin, aynı sonucu verecektir. Layer menüsünden konuyla ilgili kontroller için örnek resmi inceleyin.

12-LAYER MASK
Layer’lar arası kompozit çalışmalarda kadrajlama, tasarımın gelişme aşamasında, tasarımın değişken yapısında Layer Mask’ların (katman maskesi) önemi tartışmasızdır.
Örnek bir belge açın ve layer’da olmasına dikkat edin. Bir seçim alanı oluşturun, Layer araç paletinden ‘Add a mask’ ikonuna tıklayarak seçimi Layer Mask’a dönüştürün. Yandaki örnek resimde gördüğünüz gibi Layer Mask’a tıklayın. Burada uygulayacağınız tüm çalışmalar, filtreler sadece maskeye uygulanarak orijinal belgeye herhangi bir etkisi olmayacaktır. Maskeye, Filter> Blur> Gaussian Blur filtresini 25 radius değerinde uygulayın. Maskın erimesiyle geçişler oldukça yumuşadı. Maskeye distort filtrelerinden, artistik filtrelere kadar birçok efekti uygulayabilirsiniz. Alt tuşuna basılı tutarak mouse ile Layer Mask’ın üzerine tıklayın. Çalışma alanında gördüğünüz, maskın kendisidir. Tekrar Alt tuşu ile maska tıkladığınızda eski haline gelir. Shift tuşu ile maskeye tıkladığınızda geçiçi olarak maskeyi devre dışı bırakmış olursunuz. Command tuşu basılıyken mouse ile maskeye tıkladığınızda ise seçili (selection) duruma gelecektir

13-BLENDING
Blending Options özellikle Photoshop 7 ile birlikte daha güçlü bir şekilde karşımızda duruyor. Photoshop içerisinde katmanlar arası geçişler, komposit çalışmalar içerisinde alternatifler sınırsız. Örnek çalışmamızı Photoshop 6 üzerinden gerçekleştireceğiz. Photoshop klasörünün Samples dosyalarından Ducky ve Dune isimli belgeleri örnekte olduğu gibi yerleştirin ve Dune layer’ına gelerek çift tıklayın. Açılan Blending Options penceresinden Blend If bölümüne göz atın. Underlying Layer bölümündeki sağdaki oku 253 değerine getirin. Dune layer’ının Ducky layer’ındaki ördeğimizin içine girdiğini göreceksiniz. Bu işlemi iptal ederek soldaki sürgüyü sağa çekerek bir deneme yapalım. Bu sefer de sevgili ördeğimiz üst layer’da duruyormuş gibi görünüyor. Sürgülerin üzerine Alt tuşuyla tıklayarak birbirinden ayırabilir ve daha hassas çalışmalar yapabilirsiniz. Sizler için bir örnek daha hazırladım, farklı etkilerle test edin.

14-LAYER SET
Photoshop 6 ile birlikte gelen Layer Set, yoğun layer karmaşasına son vermiştir. Oldukça işlevli, tasarımcılara nefes aldıran bir kolaylıkla alkış aldı. Layer araç paletinde klasör ikonu görünümünde yer alan Layer Set aracı hakkında birkaç püfümüz var. Alt tuşu ile birlikte Layer Set ikonuna tıkladığınızda karşınıza Layer Set bilgi penceresi çıkar ve hangi isimde açmak istediğinizi, layer modunu, opacity değerini doğrudan girebilirsiniz. Layer paletimizde onlarca layer olduğunu kabul ederek bu layer’ları bir Set altında toplamak istiyoruz. Aynı set altında toplamak istediğiniz layer’ları birbirine bağlayarak Layer Options ayarlarından ‘New Set From Linked’ komutunu kullanabilirsiniz.

15-LAYER’DA SAYDAMLIK
Çalışma sırasında blur, feather ile yumuşatılmış, kenarları dağınık halde piksellerden oluşan bir layer’ı seçmek, böyle bir layer’a özel efekt uygulamak bize sağlıklı sonuçlar vermeyebilir. Layer araç paletindeki küçük ikonlardan ‘Lock Transparency’ ile böyle bir çalışma sorunsuzca yapılabilir.

16-LAYER MASK ile GİYDİRME
Photoshop ile özel çalışmalarımızda iki layer’ı bir bardağın, bir objenin için sarılmış, girmiş gibi göstermek isteriz. Bu tür çalışmalarda özel efekt programlarının dışında, benim kullandığım bir teknik var. Giydirme yapılacak layer’ın renk kanallarındaki gri bilgisini kullanarak mask oluşturmak. Bu konuda basit bir örnek hazırladım. Çalışmanın ana sistemini aktardıktan sonra, bu tür çalışmalarda airbrush ve layer mode’larıyla farklı tekrarlar üreterek bilginizi ezberlemeden öğrenebilirsiniz. Örnek çalışmamızda iki layer’ımız var. Background’da bulunan sıvı dolu cam şişe içerisine Layer 1’de bulunan spor yapan kadın görselini giydireceğiz. Layer 1’e Transform ve perspektif uygulayarak şişenin üzerine göre ayarladım. Şişeyi dekupe ederek hazırlığımın ilk aşamasını tamamladım.
Layer 1’in gözüne tıklayarak gizleyin. Background’un Blue kanalını duplicate yaparak gri renk seviyesiyle oynadım ve son aşamada invert ettim. Alpha kanalları, siyah ile beyazın saydamlık bilgisini taşıdığından layer mask’ta kullanmak için açık tonlu pikseller gerektiğinden invert yaptım. Hazırladığım path’i seçili duruma getirip Select menüsünden inverse komutuyla seçimi tersine çevirdim ve Blue copy kanalını siyah ile doldurdum. RGB kanala tıklayarak gizlediğim Layer1’i tekrar aktif hale getirdim. Select menüsünden Load Selection’ı açarak Channel sekmesinden Blue copy kanalını seçtim ve kapattım. Oluşan seçim alanını Layer Mask olarak kullanmam gerektiğinden seçimi mask olarak atadım.

17-LAYER MODE’LARIYLA TEK RENK HAKİMİYETİ
Photoshop içerisinde renkli bir görseli ilk önce Grayscale moduna çevirdikten sonra Duotone ile bir ya da en fazla 4 rengin karışımı ile özel efektler üretebilme imkânımız var. Bu çözümün yanında basit bir önerimiz daha söz konusu: Layer Mode’larından Luminosity ve Color seçeneklerini bu tür çalışmalarda kullanabilirsiniz. Örnek resimde Layer2’nin yapısını inceleyin.

18-PURGE
Tarihte bir RAM canavarı varsa, Photoshop’ta bunlardan bir tanesi. Yoğun çalışmalarda, kopyalanan öğelerden, yapılan işlemlerden dolayı History aracının dolması, kullanılan belleğin azalmasıyla Photoshop’un performansında azalma görülür. Edit menüsü altında bulunan Purge’e baktığımızda dört seçenek görürüz: Undo geri alma işlemlerini, Clipboard; kopyalama yapıştırma yaptığımız Clipboard hafızayı, Histories history paletindeki listeyi resetleyerek hafızadan siler. All seçeneği ise hepsini birden resetleyerek RAM’de yer kaplayan bilgileri silerek boşaltır.

19-PRESET MANAGER
Photoshop klasörünün içine baktığınızda, Preset isimli bir dosya görürsünüz. Bu dosya içinde yer alanlar Photoshop’un can damarlarını oluşturmaktadır. Özellikle Patterns klasörü hiç farkında olmadan onlarca megabayta ulaşmış olabilir. Özel kütüphane kaynakları Internet’te ücretsiz olarak dağıtılıyor. Edit menüsü altında bulunan Preset Manager aracılığıyla dışarıdan ihraç ettiğiniz kaynakları buradan Photoshop’a dahil edebilir, yönetimini buradan yapabilirsiniz.

20-ADJUSTMENT LAYER
Bu ay dergiyle birlikte verdiğimiz ek kitapçıkta Adjustment Layer’a yer vermeme rağmen, genel Photoshop püfleri içerisinde yer almalı diye düşündüm. Layer menüsünden ve Layer araç paletinden ulaşabileceğiniz adjustment layer’la renkler üzerinde istediğiniz kontrolleri ve değişiklikleri yapabilir, istediğiniz zaman geri dönebilir ya da iptal edebilirsiniz. Orijinal belgenizde hiçbir etki ve değişiklikte bulunmadan, denemeler içerisinde farklı etkiler oluşturabilirsiniz.

21-PRATİK SEÇİMLER
Photoshop içerisinde layer’da, Alpha kanallarında yer alan pikselleri hızlı ve pratik bir biçimde seçmek için klavyeden command tuşu basılı durumdayken mouse ile layer’a, alpha kanalına, path’e tıkladığınızda seçim gerçekleşir. Layer’ları ve Alpha kanalındaki maskeyi Select menüsünden Load Selection’ı kullanarak da Layer ve Alpha kanalını seçili duruma getirebilirsiniz.

22-TRANSFORM SELECTION
Seçim alanını istediğiniz biçimde büyütüp, açı verebilir, perspektif etkisi yaratabilirsiniz. Özel gölgeleme tekniklerinde, aynı forma sahip farklı büyüklükteki nesneler için kullanabileceğiniz bir araç. Selection menüsü altında bulunan Transform Selection ancak çalışma alanında bir seçim olduğunda aktif hale gelir.

23-COPY MERGED
Photoshop harikalarından bir tanesi daha. Özellikle benim çok pratik kullanımından dolayı sık sık başvurduğum bir araç. Onlarca layer’lı bir çalışmanızda ister tüm alanı, ister bir bölümünü seçip, seçim alanı içerisinde kalan gizlenmiş layer’ları görmeyen sadece aktif olan layer’ları gören Copy Merged komutu uygulandığında seçim alanı içerisinde kalan tüm layerlara, Flatten Image komutu uygulayarak hafızasında layer’ları birleştirerek kopyalar ve istediğiniz yere yapıştırabilirsiniz.

24-ARRANGE
Diğer programlarda çok sık kullandığımız, nesneler arasında yer değişikliği yaparız. Birbirlerinin altına ya da üstüne taşımak, bazen en alta bazen de en üste taşıma yaparız. Photoshop programında bunu genelde elle grçekleştiririz. Ama Photoshop içersinde de böyle bir araç ve komut dizini var. Layer menüsü altında bulunan Arrange sekmesinde layerlı bir çalışma belgesinde herhangi bir layer’ı diğer bir layer’ın altına, üstüne yada en üste taşıma gibi komutları bulunmakta.

25-YAZILI VE SESLİ MESAJ
Çalışmanızı bitirdiniz ve sizden sonra başka bir arkadaşınız bıraktığınız yerden devam edecek ya da Photoshop dökümanını başka bir yere gönderiyorsunuz.
Photoshop belgesinin içine doğrudan kendi sesinizle not bırakmaya ne dersiniz? Toolbox üzerinde bulunan bu iki araç ile gerekli notları aktarabilirsiniz.
26-APPLY IMAGE
Alpha kanallarını yoğun kullananlar için harika bir püfümüz var. Bu püfü birlikte yapmak için herhangi bir görsel açın ve iki alpha kanalı yaratın. Alpha 1’de özel bir desen olsun, Alpha 2’de ise mask görevi görecek. Benim örneğimde olduğu gibi feather verilerek oluşturulmuş bir küre olabilir. Çalışmanızı kanallarda bitirdikten sonra RGB kanala tıklayın. Image> Apply Image’ı açın. Örnek resimdeki Apply Image değerlerini girin. Preview seçeneği aktif olduğunda değişen değerler hemen çalışma dokümanında görünür. Önemli ve etkili bir araç olan Apply Images, çoğunlukla Photoshop kullanıcılarının gözden kaçırdığı bir nokta. Çalışmayı layer kullanmadan yaptık. Bir de Apply Image’ı iki layer ve Alpha kanalında bir maske görevini görecek şekilde kullandığımızda yine etkili bir sonuç alabiliriz.

27-SEÇİMİ PATH’E DÖNÜŞTÜRME
Path denilince hemen dekupaj akla geliyor. Photoshop yeni yaptığı atakla uzun ve zahmetli path çizimlerini geride bıraktıracak. Biz yine de geriye giderek halen sorunların çıktığı birkaç noktanın altını çizeceğiz.
Örnek çalışmamızda etrafı oldukça temiz bir ördeğimiz var. Magic Wand aracıyla uygun tolerans değerinde beyaz alanı seçerek seçimi inverst komutuyla tersine çevirdik. Ördeğimizin kenarlarında piksellerden dolayı kırıklı bir seçim elde ettik. Bu kırıklıkları gidermek için Select>Modify>Smooth değerine gireceğiniz piksel değeri kadar hatlar yumuşayacaktır. Ardından yine aynı bölümden Contract komutuyla 1 piksel değerinde içe doğru seçimi daralttığımızda temiz bir görüntü elde ederiz. Var olan seçimi Path’e dönüştürmek için Window>Show Paths’i açarak options sekmesinden Make Work Path komutunu verin. Tolerans değerine 0.5 değerini girin. Path paletinde isimsiz bir path oluştu, Work Path yazan yazının üzerine çift tıklayın ve bir isim vererek kaydedin. Aksi takdirde path aracıyla çizim yapmaya başladığınızda isimsiz path’iniz silinebilir. Var olan path’ini ister kopyalayarak ister File>Export>Paths to Illustrator komutya vektörel bir programa taşıyabilirsiniz.

28-STROKE PATH
Path paletinde var olan path’i bir yol olarak kabul edip, Photoshop bizim belirlediğimiz toolbox araçlardan (boyama, rötuş) birisiyle path boyunca otomatik bir şekilde önceden girilmiş değerler doğrultusunda dolaşarak müdehale eder. Stroke Path’in komutsal yönetiminin yanında pratik kullanımlar vardır. Örnek resimde gördüğünüz gibi çalışma alanı içersinde aktif bir path var ve toolbox’ta seçilmiş bir airbrush boyama aracı. Airbrush için gerekli değerler girilmişse, (fırça büyüklüğü, opacity, renk gibi) klavyeden enter tuşuna bir kere basmanız yeterli olacaktır. Eğer toolbox’ta airbrush ya da başka bir boyama aracı değil de path, zoom, move gibi araçlar varsa, command tuşu basılı durumda iken enter tuşuna basmanız path’i selection olarak aktif hale getirecektir.

29-TIFF FORMATINDA CLIPPING PATH
Photoshop içinde yaptığımız dekupajları FreeHand programına TIFF formatında Clipping Path özelliğinde kaydedip aktarabiliyoruz. EPS formatında Clipping Path daha kolay ve daha bilinir ama FreeHand programı içersinde sorunsuzca film çıkışa gönderilebiliyor.

30-CONTACT SHEET II
Özel bir katologlama sistemi. File menüsü altında, Automate seçeneğinde bulunan Contact Sheet II sürekli karıştırdığımız, aradığımızı bulamadığımız görsel kütüphanemiz içinde ön görüntülü katologlama yaparak bizi hem zaman kaybından hem de stresten kurtarır. Contact Sheet penceresini incelersek Source Folder butonunda katologlama yapılacak dosya dizinini tanımlatıyoruz. Document bölümünde ise kataloglama yapılacak sayfa ölçülerini ve çözünürlük değeri tanımlanıyor. Thumbnails bölümünde ise sayfa ölçülerini belirttiğimiz alana yatayda ve dikeyde kaç bölümden oluşacağını, bir sayfamızda kaç görsel olması gerektiğine karar veriyoruz. En son bölümde görsellerimizin altında dosya isimlerinin hangi karakterde, kaç puntoda yazılacağını belirliyoruz. Kataloglama işlemi tanımladığınız dosya dizinindeki görseller bitene kadar devam eder. Sayfa doldukça Photoshop yeni bir sayfa açarak devam eder. Çalışma bittiğinde istediğiniz formatta saklayabilir veya baskılarını yaparak arşivleyebilirsiniz. Katologlama sırasında dosya isimlerini yazdığından aramak, bulmak çok daha kolay olacaktır.

31-LAYER MODE’LARIYLA ÖZEL EFEKTLER
Layer Mode’larının birbirleriyle çarpıştırılması sonucu hoş görüntüler elde edebilirsiniz. Bu çalışmamızı RGB renk modunda uygulayacağız. Herhangi bir görsel açın, görselimiz RGB değilse Image/Mode sekmesinden RGB renk modunu seçerek dönüştürün. Son kontrollerden sonra çalışmaya başlayabiliriz. Görselimize Image/Adjust/ Invert komutunu uygulayın. Background’da bulunan çalışmamızı yeni bir layer olarak çoğaltın. Layer modunu Difference seçeneğine getirerek, Toolbox’tan Airbrush aracına tıklayın. İstediğiniz fırça büyüklüğünde ve her seferinde farklı renk tonlarında boyamalar yapın. Bu şekilde farklı alternatifler üretebilirsiniz. Çalışmanızı Offset baskı tekniğinde kullanmak isterseniz tüm layer’ları birleştirdikten sonra CMYK renk formatına çevirerek yerleştirebilirsiniz.

32-QUICK MASK-1
Quick Mask çalışma alanında bir seçili alan olması durumunda klavyeden -Q- harfine basarak devreye giren ve bu alan üzerinde Brush araçlarıyla boyayarak alan ekleme ve çıkarma yapabileceğimiz bir tekniği bize sunar. Bunun yanında var olan bir seçili alanı Quick maska dönüştürdüğümüzde uyguladığımız Distort filtreleri sayesinde farklı görünümler elde edebiliriz. Örnek görselimizde bir seçili alan yaratıp (1) onu Quick Maska çevirdik (2) ve Distort'tan Wave Efektini uygulayarak görselimizde bordür oluşturduk (3). Sonra da var olan Quick Mask’ı tekrar klavyeden -Q- harfine basarak seçili duruma getirdik. Seçili alandan yararlanarak görselimizin dış alanını boşaltarak Layer Style’den farklı etkilerde bulunduk.

33-QUICK MASK-2
CMYK renk formatında bir görsele RGB renk formatında çalışan filtreleri uygulayamazsınız. CMYK formatında iken, Alpha kanalında yapılan çalışmalara RGB renk kanalında çalışan filtrelerden bazıları uygulanabilir, Quick Mask'ta da RGB renk kanalında çalışan filtre gruplarından bazılarını çalıştıralabilir, seçili alan uygulayarak, seçim alanını Quick Mask'tan çıkardıktan sonra renk araçlarıyla veya tercih ettiğiniz farklı araçlarla müdahale edebilirsiniz. Etkisi görsele direkt uygulanmasından daha iyi olmaz ama gereksiz yere RGB-CMYK dönüşümlerinin önüne geçebilir.

34-LAYER OPACITY DEĞERİ DÜŞTÜĞÜNDE DİKKAT!
Photoshop içerisinde sıklıkla kullanılan Auto Select Layer seçeneği ne yazık ki her opacity değerinde çalışmıyor. Layer’ın opacity değeri 50’nin altına düştüğünde Auto Select Layer opacity değeri düşük layer’ı görmeyerek direkt altaki layer’ı seçiyor.

35-CREATE LAYER
Örnek bir çalışma üzerinde açıklayalım. Photoshop içersinde bir yazı yazın ve drop, bevel, stroke gibi özelliklerde yazıya efekt uygulayın. Ardından Layer menüsünden Layer Style/ Create Layer komutunu uygulayın. Örnek resimde uygulama öncesi ve sonrasını gösteren ön görüntü var.

36-HASSAS RÖTUŞLAR
Servis bürodan gelen ya da kendi dia bankımızda bulunan görsel fotoğraflarda istediğimiz gibi renk tonlamalarını yakalayamayız. Özellik insan yüzlerinde ışık patlamaları, gözlerin etrafında yoğun gölgeler istemeyen sonuçlar yaratır. Deformasyona uğratmadan, bölgedeki piksellerin tonuyla oynayan Dodge ve Burn Tool araçları bazen hayat kurtarır. Örnek resmimizde Dodge Tool ile resmin sağ tarafında gördüğünüz gibi tonlarını açtım. Burn Tool ile fazla ışık almış, noktası zayıf bölgelerin doygunluğunu arttırmak için kullanabilirsiniz.
37-PHOTOSHOP’TA TEL ÖRGÜ
Photoshop ile örnek resimde görmüş oduğunuz gibi basit bir tel örgü yapmaya çalışacağız. Burada yine kanallar karşımıza çıkıyor.

1. Ördeğimizin olduğu belgeyi açalım, az önce üzerinde bir dekupaj çalışması yaptığımızdan etrafında halen dekupe var.

2. Ördeğimizin Channel bölümüne bir Alpha kanalı ekleyerek filter> render> clouds filtresini uygulayalım.

3. Toolbox’taki foreground rengini beyaz yapın ve ardından filter> texture> stained glass filtresini açın. Resimdeki ön değerleri girin ve kapatın. Oluşan görselimizde kontrastlığı artırarak beyaz çizgileri net bir şekilde elde edeceğiz.

4. Levels tablosunu açın ve Input Levels bölümüne sırayla şu değerleri girin 47/0.10/255 ve kapatın.

5. Tel örgümüz nerdeyse hazır. RGB kanala tıklayarak boş bir layer açın.

6. Select menüsünden Load Selection’ı açarak Channel bölümünden Alpha 1’i seçerek pencereyi kapatın.

7. Oluşan seçili alana herhangibir renk doldurun. İsterseniz Layer Style’den Drop Shadow ile gölge verebilirsiniz.

8. Tel örgüyü istediğiniz biçimde seçerek Layer Mask’ı kullanarak kadrajlayabilirsiniz.

38-KULLANMADIĞINIZ LAYER’LARI GİZLEYEREK KAYDEDİN
Öyle çalışmalar olur ki 20-30 layer kullanmak zorunda kalır, Photoshop belgemiz yüzlerce MB oluverir. Örnek resimde gördüğünüz gibi aynı belgeyi tüm layer’ları gizleyerek kaydettiğimizde 20 MB bir farkın olduğunu görebilirsiniz. Layer Set’lerle çalıştığınızda gizleme ve gösterme çok daha kolay olacaktır.
39-PRINT OPTIONS
Photoshop 6 ile gelen File menüsü altında sinsice bekleyen baskıda büyük kolaylık sağlayan bir araç. Print options aracılığıyla baskılarınıza büyük bir kolaylık sağlıyor. Kağıdınıza göre Scale to Fit Media komutuyla deformasyona uğratmadan oranlı bir şekilde sığdırarak aldığınız baskılarda, kağıt rengini, ters yüz baskıyı ve birçok özelliği kontrol edebilirsiniz.

40-SEÇİM ALANINI LAYER YAPMAK
Background ya da bir layer’da herhangi bir araçla oluşturduğunuz seçim alanına Command+J tuş kombinasyonunu (Layer via Copy) uyguladığınızda seçim alanı içersinde kalan pikseller yeni bir layer olarak üstünde oluşur. Aynı seçim dahilinde Command+Shift+J tuş kombinasyonuyla (Layer via Cut) seçim alanı içinde kalan pikseller oradan kesilerek bir üst layer’ı oluştururlar.

41-SHIFT TUŞUYLA SÜRÜKLE BIRAK
Photoshop içerisinde aynı değerlerde iki farklı, açık durumda çalışma belgeniz olduğunu düşünelim. Bir belgeden diğerine layer’ları, linkli yada tek başına taşıma yaparken Shift tuşuna basılı tutarak taşımanız durumunda sürüklenen layer sayfaya göre hangi koordinatlarda ise taşındığı belgede de aynı koordinatlarda otomatik olarak yerleşir, sayfanın neresine bırakırsanız bırakın fark etmez.

42-HEALING BRUSH
Photoshop 7 ile birlikte gelen ve adından en çok söz ettiren yeniliklerden bir tanesi Healing Brush, Patch. Rötuşlar konusunda büyük bir kolaylık getiren araçların kullanımı da çok kolay. Eskisi gibi el ve bilek yetenekleri fazla gerektirmeyen bu araçlar bizlere önemli zaman kazandıracak. Aracı kullanmak için Stamp aracında olduğu gibi Alt tuşuna basarak dokuyu taşıyacağımız bir merkez alıyoruz, ardından gerekli yerlerin rötuşuna başlayabilirsiniz. Stamp aracından ayrılan en önemli özelliği “Clone” yapıldığı bölgenin pikselleriyle homojen bir yapıyla kaynaşması ve piksellerin renk ve doku bilgisini alarak taşınan dokuyu bu bilgiler içerisinde aktarması.

43-PATCH TOOL
Photoshop’un sayısız harikalarından biri. Doku taşıma konusunda şaşırtıcı bir yeteneğe sahip. Rötuşun yapılacağı alanı Patch Tool aracıyla çizerek belirliyorsunuz, sonra bu alana giydirmek istediğiniz dokunun üzerine seçili alanı sürüklüyorsunuz, hepsi bu kadar. Rötuş, çalışmanızın hassaslığına göre Patch Tool ile alanı belirledikten sonra Feather değeri verebiliyorsunuz.

44-SNAPSHOT
History araç paletinin içinde gizlenmiş bizi bekleyen önemli bir araç. Bildiğiniz gibi History araç paleti yaptığımız işlemleri tek tek hafızasına alarak istenildiğinde geri alıp, sonra tekrar çalışmaya başlayabildiğimiz bir araç. Çalışma içinde oluşturduğumuz etkilerde karar veremediğimizde, devam ederek farklı etkiler yakalamak istediğimiz olur. Böyle bir karar öncesi çalışma ekranımızın ve layer’ların tüm özellikleriyle aynı belge içerisinde bir yedeğini alarak çalışmanın sonunda karşılaştırmasını yapmak için History araç paletindeki Snapshot’ı kullanmak oldukça pratik bir çözümdür.

45-PRATİK LAYER KOPYALAMA
Photoshop’ta içinde bulunduğunuz layer’ın kopyasını üretmek için çok basit bir önerimiz var. Layer’da iken klavyeden alt tuşuna basarken yönlendirme oklarından herhangi birine bir kere basmanız yeterli.

46-LAYER BİRLEŞTİRME
Layer paletimizde, çalışmanın netleştiği bir noktada onlarca Layer’ımızı birbirleriyle birleştirir çalışmayı toparlarız. Menüden ve layer options’tan birleştirmeleri kontrol edebileceğimiz gibi klavyeden de gerekli ayarlamaları yapabiliriz.
Command+E tuş kombinasyonuyla aktif olan layer bir altındaki layer’la birleşir. Command+Shift+E, komutunu verebilmek için aktif bir layer’da olmanız gerekiyor. Layer araç paletinde gizlenmiş layer’Iarın dışında tüm layer’ları birleştirir. Background layer’ında iken verilirse tüm layer’lar background’da bütünleşir. Birbirine link’lenmiş layer’ların hepsini Command+E ile bir kerede birleştirebilirsiniz.

47-TOOL BOX RENK KONTROLÜ
Çalışmalarımız sırasında tool box’taki foreground ve background renklerini resetler, yer değiştirir, çalışma alanı içersinden damlalık aracıyla renk örneği alırız. Tool Box renklerini resetlemek için klavyeden ‘D’ tuşuna bir kere basmanız durumunda renkler siyah ve beyaza döner, ‘X’ tuşuna bastığınızda foreground ile background renkleri yer değiştirir.
Damlalık ikonuna tıkladıktan sonra alt tuşuyla örnek bir görsele tıkladığında background rengi için örnek alırız. Shift tuşuyla tıkladığımızda ‘Point Sample’lar bırakır, renk düzeltmelerinde çalışma alanının renk dağılımını info araç paletinden kontrol edebiliriz.
Swatches renk paletinden örnek alırken, background için command tuşuna basarak tıklamanız gerekmektedir. Alt tuşuyla swatches renk paletine tıkladığımız, mouse’un kursörü makas’a dönüşerek tıklanan rengi oradan keserek alıyor.

48-GRADIENT MAP
Photoshop 7 içinde özel renklerden oluşan efekt çalışmalarınızda etkili bir araç. Image/ Adjustment/ Gradient Map’i açtığınızda bir degrade çalışması yapıyor hissini verecektir. Özel oluşturabileceğiniz renkler, bazı durumlarda ‘Reverse’ ile zıt kombinasyonlarla etkili ve kolay bir sonuç için kullanılabilir.

49-HISTORY BRUSH
Hazır görsellerinizden bir tanesini açın. Örneğimizin algılanması için üzerine, layer açmaya gerek yok, renklerini sizin belirleyeceğiniz bir Clouds filtresi uygulayın. Ardından Toolbox’tan History Brush’ı seçerek örnek resimdeki değerlerde fırçanızı kullanın. History Brush, son kaydedileni hafızasında tuttuğundan tekrar onu geri aktarırken özel layer mode’larını kullanmamız sonucu hoş çalışmalar elde ediyoruz. Layer Modu’nu Normal’e getirdiğimizde direkt son kaydedilen pikseller fırçanın müdahale ettiği noktalarda ortaya çıkar.
